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Empower Privileges Pertaining to Versions Empower 3  
Service Release 3 through 3.9.0

This technical note is intended to provide granular details on User Type privileges 
in Waters™ Empower™ Chromatography Data System (CDS) and provides 
supplemental information to that described in Empower Help. 

This document describes the following topics:

	■ Privileges implicit to the Administrator privilege

	■ Actions available to a user with the Alter Any Project privilege

	■ User Group Administrator Functionality

	■ Empower Privilege dependencies

PRIVILEGES IMPLICIT TO THE ADMINISTRATOR PRIVILEGE
Implicit privileges those that are included within the Administrator privilege and for which an 
equivalent explicit privilege does not exist. These privileges cannot be removed from a User Type 
that includes the Administrator privilege. Starting with Empower 3.6.1, some of these privileges are 
available as explicit privileges and are assignable to non-administrator User Types. The following 
actions are available to a user who has the Administrator privilege:

Table 1. Administrator privilege
Archive and remove System Audit Trail
	 Refer to Empower Privilege Dependencies section of this document for more information on this privilege.
Manage offline System Audit Trails
Manage View Filters  
	 In Empower 3.7.0 and prior versions, the following capabilities are implicit within the Administrator privilege:
	 •	Access private View Filters 
	 •	Delete private View Filters 
	 •	Copy private View Filters between Projects (Copy to Project menu)

	 As of Empower 3.8.0, the following privileges control these activities and are assignable to users as appropriate:
	 •	Access All View Filters
	 •	Delete All View Filters
	 •	The Copy to Project is needed in order to copy Public or Private View Filters between Projects. No additional View  
      Filter privileges are required. 

In all Empower versions, the View Filter owner can delete their own View Filters, both private and public.
Alter User Info in the About Dialog (Name, Company, Software Support ID)
Access/View All Projects  
	 In Empower 3.6.0 and prior versions, the ability to access all Projects is a capability implicit 
	 within the Administrator privilege. 

	 In Empower 3.6.1 and later, the Access All Projects privilege is available. 

	 Refer to the Empower Privilege Dependencies section of this document for more information on this privilege.
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Manage Nodes without explicit access

	 In Empower 3.7.0 and prior versions, the ability to manage Nodes (change Owner and other parameters 
	 in Node properties) is implicit within the Administrator privilege. 

	 As of Empower 3.8.0, the Access All Nodes privilege is available. 

	 Refer to the Empower Privilege Dependencies section of this document for more information on this privilege.
Manage Systems without explicit access

	 In Empower 3.7.0 and prior versions, the ability to manage Systems (change Owner and other 
	 parameters in System properties) is implicit within the Administrator privilege. 

	 As of Empower 3.8.0, the Access All Systems privilege is available. 

	 Refer to the Empower Privilege Dependencies section of this document for more information on this privilege.
Manage Database Properties
Manage Auto Archive Properties (Empower Personal only)
Backup Database

Cancel Pending SDMS Operation (if SDMS is installed)

Manage Empower Licenses via the Waters Licensing Wizard

In Empower 3.7.0 and prior versions, the ability to log in to, and manage software licenses 
is implicit within the Administrator privilege.

As of Empower 3.8.0, the Manage Licenses privilege is available.
Reset Passwords for Administrative Users
Receive Failed Login Attempt Popup Messages

ACTIONS AVAILABLE TO A USER WITH THE ALTER ANY PROJECT PRIVILEGE

A user with only the Alter Any Project privilege has the ability to perform the following actions:

Table 2. Alter Any Project privilege
Modify any parameters within Project properties with the exception of performing any actions related to Custom Fields 
	 Note: In Empower 3 Feature Release 4 and prior versions, the Alter Any Project privilege included all privileges related 
	 to Custom Fields. 
   Tip: For more granular control of Projects, leverage the following privileges instead of assigning the Alter Any Project 
   privilege (assigns all listed below): 
   • Change Project Parent 
   • Change Project Owner 
   • Alter Project Type 
   • Lock Project 
   • Unlock Project
Rename Project and Modify Project Comments 
	 Note: This capability only works when changing the name or comment of a Project that has no child Project(s), 
	 or for a user that does not have access to the child Project(s).

Lock and Unlock Projects

Change Project Auto Archive On/Off (Empower Personal only)
Clone a Project via File > Clone (Clone a Project at the root if the user also has Create Projects at the Root privilege) 
	 Note: Additional privileges are required when cloning Projects. Refer to the Empower Privilege Dependencies section of 
   this document for more information.

Table 1. Administrator privilege – continued
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USER GROUP ADMINISTRATOR FUNCTIONALITY
A user defined as the Group Administrator can add and remove members from the User Group 
using the Group Properties tab. The Group Administrator cannot add or delete users in the 
Empower database via the Admin Properties tab or change the User Status using the Group 
Properties tab unless their User Type contains the privileges required to perform the activities.

Deleting users is affected by the Enforce Unique User Account Names System Policy. With this 
System Policy enabled, Users cannot be deleted. Instead, when a Group Administrator selects 
Delete User, the User is removed (deleted) from the User Group but remains in the Empower 
system with the User Status set to Removed.

Assigning a Group Administrator is optional.

EMPOWER PRIVILEGE DEPENDENCIES
The following intricacies should be understood when providing users the appropriate access within 
Empower Software.

Table 3. Empower privilege dependencies

Privilege or action Privileges dependencies

Clone a Project, including built-in 
and user-created Custom Fields

Path: File > Clone

Empower 3 Versions: Feature Release 
4 Service Release 3, Feature Release 5, 
Feature Release 5 Service Release 4

To successfully clone a Project or create a new Project, the user 
must have the following privileges:
	 •	 Create Projects
	 •	 Alter Any Project
	 •	 Create Custom Field
	 •	 Create Projects at the Root (if user needs to create or clone at the root)

Clone a Project, including built-in 
and user-created Custom Fields

Path: File > Clone

Empower 3 Versions: Feature Release 5 
Service Release 5 and later

To successfully clone a Project or create a new Project, the user must 
have the following privileges:
	 •	 Create Projects 
	 •	 Alter Any Project 
	 •	 Create Projects at the Root (if user needs to clone at the root)

Per CRI-289, the Create Custom Field privilege is no longer needed for 
this action in version Empower 3 Feature Release 5 Service Release 5 and later.

Define Project Type during  
Project creation

Project Type (Standard, Validation 
Working, Validation Template) is  
applicable only when the Method 
Validation Manager (MVM) option  
is enabled

To define a Project Type when creating a new Project, the user must 
have the following privileges:
	 •	 Create Projects  
			  (and either) 
	 •	 Alter Any Project  
			  (or)
	 •	 Alter Project Type
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Table 3. Empower privilege dependencies – continued

Privilege or action Privileges dependencies

Copy Custom Fields between Projects 
from the Project window

To copy Custom Fields between Projects from the Project Window, the user must 
have the following privileges:
	 •	 Copy to Projects
	 •	 Alter Custom Field (only if modifying an existing custom field in 
			  destination project)
	 •	 Due to minor differences between versions, you may need the Create Custom 	
			  Field privilege when copying Custom Fields between Projects if you are 
      copying a Custom Field that does not exist in the destination Project.

Copy or drag and drop data and  
methods between Projects

Dragging and dropping objects between Projects is considered a copy action. 
As such, in order to drag and drop objects between Projects, the user must 
have the following privilege:
	 •	 Copy to Project

This privilege is also required in order to drag and drop data Channels into the 
Review window.

This privilege is intended to assist with Project seeding  
and allows users to copy (and drag and drop) objects such  
as raw data, Results, Methods, View Filters, and so on between Projects. 

A user needs access to both the source and destination Projects to copy objects 
between Projects. Users do not need a corresponding privilege such as Save 
Method to perform a copy action. 

Note: Refer to the Implications of Project Group and World Access (logged-on user 
type vs. Project context user type) section of this document for more information.

Access All Projects

Versions Empower 3.6.1 and later

This privilege allows a user to access a Project or Projects regardless of the 
allowed access defined in the Project properties. A user with this privilege can 
open and view all existing Projects. To alter Project properties, perform Project-
based tasks (such as clone, backup, or create), and manage data in such a Project, 
the user must have the appropriate user privilege(s) in addition to the Access All 
Projects privilege.

When a user has this privilege, their User Type within a Project does not change 
based on the Group User Type or World User Type access setting for the Project 
and remains as the logged-on User Type.

Access All Nodes

Version Empower 3.8.0 and later

This privilege allows a user to view and access all existing Nodes configured 
in Empower Software, regardless of the Allowed Access defined in the Node 
Properties. In order to perform actions on a Node, the User Type of this user must 
have the appropriate privileges, such as Alter Node and Delete Node.

In all Empower Software versions, the Node Owner can manage and delete their 
own Nodes.

Access All Systems

Version Empower 3.8.0 and later

This privilege allows a user to view and access all existing chromatographic Systems 
configured in Empower Software, regardless of the Allowed Access defined in the 
System Properties. To perform actions on the System, the User Type assigned to 
the user must additionally have the appropriate privileges, such as Alter System and 
Delete System.

In all Empower versions, the System Owner can manage and delete their own 
Systems.
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Table 3. Empower privilege dependencies – continued

Privilege or action Privileges dependencies

Allow Interactive Sys Changes This privilege allows interactive changes to any instrument parameter via the 
Run Samples instrument Control Panels in the Run Samples window. Users with 
this privilege also need the Acquire Samples privilege. A user not assigned this 
privilege cannot change these instrument parameter settings in Run Samples 
with the exception of the Stop Flow capability (for safety reasons). When data is 
not being acquired, these instrument parameters can be changed by users both 
with and without this privilege. 

Restriction: This privilege pertains only to Waters and Agilent instruments that 
are natively controlled by Empower Software using no external instrument driver.  
Waters instruments that use instrument control software (ICS) and Agilent LC  
and GC instruments using legacy ICS drivers or ICF Support Layer drivers ignore 
this privilege and allow all users to make interactive changes only when data is 
not being acquired. During acquisition, no interactive system changes using the  
Run Samples instrument control panels are allowed.

Exception: When using the Thermo SII v1.1 driver and the Allow Interactive Sys 
Changes Allow Interactive Sys Changes privilege is disabled, the user can make 
interactive changes during acquisition. This issue is corrected in Thermo SII v1.2 
(CRI-2595).

View Quantitation Peak 
Fields in Review

This privilege allows the user to view the following fields in the Review window 
Peaks Table: 
	 •	 Area
	 •	 % Area
	 •	 Height
	 •	 % Height
	 •	 Amount
	 •	 % Amount
	 •	 Response
	 •	 Concentration

In versions Empower 3 Feature Release 4 Service Release 3 and later, the View 
Numerical and Textual Results in Review privilege is also required in order for 
users to view these quantitation fields.

To remove the ability to view certain Peak and/or Result fields, remove one of the 
following privileges from the appropriate User Type:
     •	View Quantitation Peak Fields in Review  
        (or)
	 •	 View Numerical and Textual Results in Review
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Privilege or action Privileges dependencies

As of Empower 3.8.1, this privilege provides the same functionality as described 
above, in addition to the following: 
Allows the user to view the following fields in the Peaks tab of the Review window:
     •	Time Corr. Area (when CE/CIA is enabled)
	 •	 % Time Corr. Area (when CE/CIA option enabled)
	 •	 Relative Response
	 •	 Impurity Response
	 •	 % Adjusted Area
	 •	 Corrected Area~
	 •	 Dissolved Amount (when Dissolution option enabled)
	 •	 Dissolved Percent (when Dissolution option enabled) 
     •	All Peak Type Custom Fields

Allows the user to view the following fields in the Results window of the  
Review window:
     •	Adjusted Total Area
	 •	 Maximum Impurity Response
     •	All Result Type Custom Fields 
Note: Users not assigned this privilege cannot view these fields nor will they 
be visible in the properties of the peak or Results table Peak or Results Tables.
Additionally, users not assigned this privilege cannot add these fields as Labels or 
Legends in the plots in the Review window..

Logging into Empower 
in Citrix environment. 
Empower 3 Versions Feature Release 4 
Service Release 3 and later

In Empower 3 Feature Release 4 Service Release 3 through 3.7.0, the Create Node 
privilege is required to log in to Empower Software for the first time from any new 
Empower Node within a Citrix environment. This privilege is not required when 
logging in to existing Empower Nodes.

As of Empower 3.8.0, the Create Node privilege is not required in order to log 
into a Node within your Empower Software Citrix environment.

Archive and Remove 
System Audit Trail

In Empower 3.7.0 and prior versions, two users with the Administrator privilege 
OR two users with the Archive System Audit Trails privilege are required in order 
to Archive the System Audit Trail. Additionally, two users with the Administrator 
privilege are required to Archive and Remove the System Audit Trail.

As of Empower 3.8.0, Archiving the System Audit Trail requires two users with the 
Administrator privilege users OR two users each with the following privileges:
	 •	 View System Audit Trails
	 •	 Archive System Audit Trails 
Additionally, Archiving and Removing the System Audit Trail requires two users 
with the Administrator privilege OR two users each with the following privileges:
     •	View System Audit Trails
	 •	 Archive System Audit Trails
     •	Delete System Audit Trails

Table 3. Empower privilege dependencies – continued
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Table 3. Empower privilege dependencies – continued

Privilege or action Privileges dependencies

Granting Privileges to User Types Users cannot grant a privilege to a User Type that their own User Types does  
not have.

View Sample History This activity (Alter Sample > Edit > View Sample History or 
Right-click > View Sample History) requires the following privilege: 
	 •	 Edit Sample Sets 

Lock Methods / Unlock Methods In order to Lock or Unlock a Method, the “Save” privilege for that particular 
Method Type is also required.

Alter a Running Sample Set 
Initiated by the User

This activity requires the following privileges:
	 •	 Alter Running Sample Sets
	 •	 Alter My Queue

If there are Sample Sets in the queue initiated by another user, this user  
requires the Alter Any Queue privilege in addition to or instead of the  
Alter My Queue privilege.

Alter a Running Sample Set 
Initiated by another User

This activity requires the following privileges:
	 •	 Alter Running Sample Sets
	 •	 Alter Any Queue

Abort a Sample Set Initiated  
by the User

This activity requires the following privileges:
	 •	 Alter Running Sample Sets
	 •	 Alter My Queue

This is true, even if there are Sample Sets in the queue by another user.

Abort a Sample Set Initiated  
by another User

This activity requires the following privilege:
	 •	 Alter Any Queue

Save Results and Calibrations via manual 
processing in the Review window  
(as opposed to batch processing)

This activity requires the following privileges:
	 •	 Save Results
	 •	 Save Calibration Curves
	 •	 Save Results and Calibrations in Review

Save Calibration Curves in the  
Review Window

This activity requires the following privileges:
	 •	 Save Calibration Curves
	 •	 Save Results and Calibration in Review Privilege

Manually integrate and quantify unknown 
samples against the calibration curve 
associated with the processing method 
and save these Results BUT NOT modify 
and save a calibration curve generated in 
the Review window. 

Disabling the Save Calibration Curves 
privilege can be used as an effective 
approach to prevent manual changes to a 
calibration curve.

Users with the following privileges:
	 •	 Save Results 
	 •	 Save Results and Calibration in Review

AND NOT
	 •	 Save Calibration Curves
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IMPLICATIONS OF PROJECT GROUP ACCESS AND GROUP AND WORLD ACCESS 
(LOGGED-ON USER TYPE VS. PROJECT CONTEXT USER TYPE)
When a user has access to a Project, the user may gain that access as a User Type alternate to that 
of their logged-on User Type due to the Group or World User Type access setting in the Project 
Properties.  This alternate User Type - called Project context User Type - and privileges therein 
then apply to that project. Actions that involve other projects or other objects such as those within 
Configuration Manager are still governed by this users’ logged-on User Type.

This means:
	■ An action such as copying to a Project, which involves another Project as the copy destination 

can be performed only if the logged-on User Type has the Copy to Project privilege.

	■ Any action involving Custom Fields, is effectively done within Configuration Manager 
and is outside of Project context. Custom Field activities can be performed only if the 
logged-on User Type has the appropriate Custom Field privilege.

	■ Acquiring a Sample Set involves objects (Node and System) outside of a Project. Because 
acquisition occurs within a given Project it is governed by the privileges of the Project context 
User Type. However, the user must also have access to the appropriate System to acquire data. 
Additionally, if it is necessary to bring the System online, the user’s logged-on User Type must 
have the privilege to do so.

	■ The Alter My Queue privilege is governed by the Project context User Type.

	■ The Alter Any Queue privilege is governed by the logged-on User Type.


